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Introduksjon 

Hva er EndNote?  
EndNote er en av flere tilgjengelige referansehåndteringsprogram.  
EndNote kan brukes til: 
 

• Vedlikehold av en personlig database med referanser 
• Laste ned referanser fra andre databaser 
• Sette inn referanser i word-dokument 
• Lage litteraturlister i samsvar med ulike bibliografiske stiler 

 
Denne veiledningen er ment å gi en kort oversikt over sentrale begreper og de viktigste 
funksjonene, nok til at du skal kunne ta ibruk programmet. 
 
Veiledningen tar utgangspunkt i EndNote versjon X5. De fleste funksjonene beskrevet i 
denne veiledningen fungerer på lignende måte også i tidligere versjoner.  
 
Denne veiledningen baseres på operativsystemet Windows. EndNote finnes også for 
Macintosh. De to versjonene er veldig like.  
 

Tilgang og installasjon 
Høgskolen i Lillehammer har en lisens som gir alle masterstudenter og vitenskaplige ansatte 
tilgang til programmet. Avtalen dekker bruk av programvaren både hjemme og på jobb.  
 
Programmet kan lastes ned fra Fronter eller du kan låne en CD/minnepinne. For Mac-
brukere er programmet kun tilgjengelig på CD. På bibliotekets EndNote side finner du 
informasjon om hvordan få tilgang. 
 
 
Kompatibilitet 
 
EndNote X5 (PC) 
 
Windows XP (SP3), Vista (32-/64-bit) og 
Windows 7 (32-/64-bit) 
 
Microsoft Word 2003, 2007 & 2010 (32/64-
bit). OpenOffice.org Writer 3 
 

EndNote X5 (Mac ) 
 
Mac OS X (10.5.x and 10.6.x, 10.7) 
 
Microsoft Word 2008 (SP1), 2011 
Pages `09 
 

 

Tips og veiledninger 
Denne veiledningen er ikke fullstendig, bruk derfor også bibliotekets EndNote side: 
http://www.hil.no/biblioteket/forskning_og_publisering/endnote 
Der finner du bl.a FAQ, 
I tillegg finnes det veldig bra hjelpesider i EndNote. 
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EndNote bibliotek  

Start EndNote programmet 
 

Åpne EndNote via Start-menyen: Programmer > EndNote > EndNote Program 

Opprette et nytt bibliotek 
 

Første gang du starter programmet får du følgende 

valg (se ill).:  

1. Velg Create a new library 

     Kall det "My EndNote library” eller lag et eget    

     navn 

 

Du må opprette et bibliotek (library) for å kunne lagre 

referanser i EndNote. 

 

2. Velg hvor biblioteket skal lagres (Ansatte: lagre på 

     eget hjemmeområde H). 

 

Åpne eksisterende bibliotek  

Velg File > Open 

Lage en sikkerhetskopi- / videresende et bibliotek 

• Ønsker du å ta en sikkerhetskopi av biblioteket ditt? 

• Behov for å sende biblioteket som vedlegg til e-post? 

• Behov for å flytte det fra et lagringssted til et annet (jobber du på ulike maskiner)? 

 

Når du lager et bibliotek får det filendelsen .enl  

Et bibliotek er en fil som kan behandles på omtrent samme måte som f.eks. Word-filer, men 

hvis du skal flytte/kopiere et bibliotek (.enl-filen) må du huske også flytte/kopiere tilhørende 

.DATA-mappe. 

 

 

Lag et nytt 

bibliotek 
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Data-mappe  

Et bibliotek får automatisk en tilhørende .Data-mappe som har 

samme navn og plassering som biblioteket. Filer (Pdf-filer, figurer, 

bilder etc.) som lenkes til en referanse kopieres automatisk til denne 

Data-mappen. 

 

 

Slik samler du alle filer som utgjør et bibliotek til én enkelt fil for å kunne flytte/sende fila:  

 

1. Velg File >  Compressed library  (.enlx).  

Merk av for de aktuelle valgene i dialogboksen  

2. Klikk Next  og angi deretter filnavn og plassering for det komprimerte EndNote-biblioteket.  

 

Den nye filen får endelsen .enlx og åpnes som om den var en vanlig EndNote-fil. Når 

programmet åpner denne typen filer vil det lage en bibliotek-fil som får endelsen .enl og en 

.DATA-mappe som inneholder alle filer tilhørende biblioteket.  

 

Nyttig tips er å inkludere dato i filnavnet til backup'en f.eks Oppgava_kopi_1mars2009 

 

Åpne sikkerhetskopien  gjøres enkelt ved hjelp av File > Open > Open Library  

EndNote vil da åpne bibliotekfila og pakke ut datamappa i den samme mappa hvor .enlx fila 

var plassert. 

 

Ett eller flere bibliotek? 

Du kan opprette flere bibliotek, men vi anbefaler at du kun har et bibliotek. Det vil gjøre det 

enklere når referansene skal benyttes i dokumenter. I stedet for å lage mange emnebibliotek 

bør du gruppere referansene (se kap. Grupper referanser) og/eller sette på emneord slik at 

referansene lett kan søkes opp.  
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Eksempel på et bibliotek: 

 
 
 
 
 
 

 
 

 

 
Ditt bibliotek vil kunne inneholde referanser til ulike  kildetyper f.eks  bøker, tidsskriftsartikler, 

avisartikler etc. De ulike kildetypene kalles for reference types. Det finnes 48 ulike 

referansetyper som hver kan inneholde inntil 51 felt. 

 

Hvilke felt og hvordan fylle ut de ulike feltene i en referanse? 
 
Det er viktig å velge rett reference type. Ulike referansetyper gir ulike felt å fylle ut.  

Vær nøye med å registrere riktige opplysninger i riktige felt! 

På bibliotekets nettside finnes en veiledning i hvordan de mest brukte referansetypene skal 

registreres: http://www.hil.no/biblioteket/forskning_og_publisering/endnote/referansetyper 

Viser valgt bibliografisk 
stil (Output Style ) 

Fanen Preview viser hvordan den markerte referansen 
vil se ut i litteraturlisten med den valgte bibliografiske 
stilen. 
 

Fanen Search gir deg 
mulighet til å søke i eget 
bibliotek 

Alle referansene i 
biblioteket grupperes  
under All References. I 
tillegg kan du lage dine 
egne grupper. 

Fanen PDF & Quick Edit gir 
deg mulighet til å redigere 
referansen uten å måtte 
åpne den i eget vindu. 

Søk på hele eller deler av 
ord. Søker i alle felt i 
biblioteket. 
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Legg inn referanser manuelt  

1. Velg  eller References > New Reference   

 

 

 

2. Velg riktig Reference Type fra nedtrekksmenyen 

Standard Reference Type er ”Journal Article”. 

 

Journal article : tidsskriftsartikkel 

Book : bok skrevet av en eller flere forfattere 

Edited Book : bok redigert av en eller flere redaktører 

Book Section : deler av redigert eller ikke-redigert bok (f.eks et kapittel) 

Web Page : nettside 

 

3. Fyll ut de nødvendige opplysningene.  

Bruk TAB-tasten for å forflytte deg fra felt til felt 

 

 
 

Lagre / stenge 

Det er viktig å velge rett 
Reference Type. Eksempel på 
en bok. 
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Informasjon om enkelte av feltene  

 
Reference Type  Velg riktig Reference Type. Ulike referansetyper gir ulike felt å 

fylle ut. 
  
Author  /Editor  

 

 

                     Eks.: 

 

 

 

 

 

 

Eks.: 

 

 

 

 

 

 

Eks.: 

Skrives Etternavn, Fornavn Mellomnavn   

Skriv inn fullt navn dersom det er kjent.  

 

”P.R. Smith”           ”Smith, P.R.” 

“Paul Roy Smith”            “Smith, Paul Roy” 

“Charles de Gaulle”         “de Gaulle, Charles” 

 

Flere forfattere 

Bruk et linjeskift mellom hver forfatter når det er flere. 

 

Jensen, Arne Olav 

Vigt, Kari 

 

Institusjon eller organisasjon som forfatter  

 skriv komma etter navnet: 

(dette fordi all tekst foran komma tolkes som et etternavn). 

 

Sosial og helsedirektoratet, 

 

Ukjent forfatter  

la forfatterfeltet være tomt 

 

Det er vesentlig at samme forfatternavn skrives likt alle ganger det 

brukes, benytt derfor Term lists. 

  

Title  

 

 

 

Skrives inn uten punktum  

 

Undertittel  

sett : (kolon) mellom hoved- og undertittel  
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Year Skriv inn årstallet 

  

Journal  Skriv inn fullt tidsskriftsnavn. Alle tidsskriftsnavn som legges inn, lagres 

også i Journals Term List 

  

Pages Skrives fullt ut (1442-1449) eller forkortet (1442-9).  

Ikke skriv p. eller s. 

  

Edition  

 

                   Eks.: 

Skriv inn tallet for utgave, ikke skriv utg. eller ed. 

 

 2 

  

DOI 

 

 

 

 

                     Eks.: 

Skriv inn DOI 

På elektroniske tidsskriftsartikler oppgis et såkalt DOI-nummer (Digital 

Object Identifier) i stedet for en URL. APA anbefaler at DOI oppgis.  

DOI-nummeret øker forøvrig EndNotes evne til å finne fulltekst. 

 

10.1093/bjsw/bch088. 

  

Keywords  Skriv inn emneord.  

Ved import fra databaser vil emneordene fra basene legges i dette 

feltet. Kan slettes eller endres.  

Bruk et linjeskift, semikolon ; eller skråstek /  mellom hvert emneord  

 

Det opprettes en emneordsliste (keywords Term lists) over emneordene 

du bruker. 

Keywords er et søkbart felt. 

  

Abstr act  

 

 

Sammendrag av artikkelen.  

Ved import fra databaser vil sammendraget legges her. For egne 

notater bruk f.eks Research Notes 

  

Research Notes Kan brukes til egne notater. 
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URL  Legg inn lenke til webadresse. 

  

File Attachment s Last opp pdf-filer. 

Pdf-filene lagres automatisk i bibliotekets DATA-mappe 

  
  
Figure  Last opp figurer 
 
 
 
NB!  Ikke sett parenteser rundt årstall, tittelen i kursiv eller punktum i de ulike feltene. Valg av    

stil (Output Style) ordner den nødvendige tegnsettingen til referansene.  

Bruk Term list (ordliste) der det er mulig. Da sikrer du at tidsskrifts-, forfatternavn og emneord 

skrives likt i de ulike referansene. Mer om Term list i eget kapittel. 

 

Administrere og redigere referanser 

 

Lagre referanser 

Lukk referansen ved å klikke på X øverst i høyre hjørne i referansevinduet eller velg File > 

Close Reference på menyen.  

All informasjon blir automatisk lagret når referansevinduet lukkes og referansen vil føye seg 

til de andre referansene i biblioteket ditt. 

 
Åpne og endre referanser 

Referansen åpnes ved å dobbeltklikke på den. Foreta ønsket endring og endringene vil 

lagres automatisk når registreringsvinduet lukkes. 

 

Du kan også redigere en referanse ved hjelp av fanen PDF & Quick Edit . Den gir deg 

mulighet til å redigere en referanse uten å måtte åpne den. 

Merke referanser 

Enkeltreferanse: Klikk en gang på referansen 

Flere referanser etter hverandre: klikk på den første referansen, hold Shift-tasten nede og 

klikk på den siste 
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Flere ”spredte” referanser: hold nede Ctrl-tasten, mens du klikker på referansene. 

Slette referanser 

1. Merk de(n) referansen(e) som skal slettes. Flere referanser merkes ved å holde Ctrl-

tasten nede.  

2. Trykk Delete  eller velg References > Move References to Trash   

 

De slettede referansene vil bli liggende i Trash  helt til du stenger biblioteket.  

NB! Ikke slett referanser som du har henvist til i et Word-dokument. 

 
 

Gjøre endringer i flere referanser samtidig 

 

Legge til tekst i et felt 

Et eksempel er når du ønsker å legge til egne keywords i flere referanser 

 

1. Merk ønskede referanser  

2. Velg References > Show Selected References  

da vises en liste over kun de merkede referansene 

3. Velg Tools > Change and Move Fields  

Velg aktuelt felt, f.eks Keywords og hva du vil legge til og hvordan 

 

Erstatte eller slette tekst 

Aktuelt om du f.eks ønsker å endre egne keywords 

 

1. Merk ønskede referanser  

Velg References > Show Selected Refere nces 

da vises en liste over kun de merkede referansene 

2. Edit > Change Text 

Sortere referanser 
 
Alle kolonnene kan sorteres. Klikk på overskriften for den kolonnen du vil sortere etter. Klikk 

på overskriften på nytt for å skifte mellom stigende og synkende sortering.  

For mer avansert sortering velg Tools > Sort Library  
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Søk etter referanser 
 
Med fanen Search  nederst på skjermbildet eller med Quick Search  (øverst til høyre) kan du søke etter 

referanser i ditt eget bibliotek.  

Du kan søke på hele eller deler av et ord.  De aller fleste felt er søkbare.  

 

Finne dubletter 
Sjekk at ikke samme referanse er registrert flere ganger i biblioteket ditt: 

1. Stå i All References 

2. Velg References > Find Duplicates  

Du får nå mulighet til å sammenligne og velge hvilken av de to dublettreferansene du ønsker å 

beholde.  

Den eldste av de to referansene ligger alltid til venstre. 

De feltene som er ulike i de to referansene er uthevet slik at du lett kan kopiere/flytte innhold før den 

ene referansen slettes. 

3. Klikk på Keep This Record  for den referansen du ønsker å beholde 

 

Automatisk sletting av dubletter 

Ved bruk av Online Search kan du sikre deg at referanser som allerede ligger i biblioteket ditt ikke blir 

importert på nytt. Dette gjøres på følgende måte:  

Edit > Preferences > Duplicates >  hak av for Automatically discard dublicates 

 

Legge pdf-filer til referansene 

1. Finn feltet File Attachments  

2. Høyreklikk og velg File Attachments/Attach  File . Finn fila, og velg OK.  

Sørg for at det er krysset av i boksen for ”Copy this file to the default file attachment  and…”. Dette 

betyr at pdf-fila nå blir tilgjengelig uavhengig av nettilgang. 

 
Søk i pdf-filene (fulltekst) 

 
Søk i innholdet i pdf-filene enten separat eller i 

kombinasjon med de bibliografiske dataene 
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Gruppér referanser   

 
Referansene kan organiseres i grupper (groups). Dette vil kunne gi en bedre oversikt. En 

referanse kan ligge i flere grupper. Alle referansene inngår i gruppen All References. 

Referanser som ikke tilhører noen gruppe vil automatisk inngå i gruppen Unfiled.  

 

 

 

EndNote opererer med to hovedkategorier av grupper: 

 

1.  De permanente og midlertidige gruppene  

F.eks All References, Imported References, Trash, Search Results, Find Full Text 

2.  Egendefinerte grupper: 

a)  Custom Groups    

selvlagde grupper hvor du manuelt overfører relevante referanser (drag-and-drop 

eller kopier) 

Eksempel på grupper: teori, empiri 

 

b)  Smart Groups  

Grupper hvor du setter opp faste profiler slik som et sett av søkeord. Hver gang du 

søker i en database og får treff på søkeordene, vil smartgruppen oppdateres med 

de aktuelle treffene som lastes ned. 

 

Alle gruppene, med unntak av All References og de egendefinerte gruppene, er 

Oversikt over alle 
referanser i biblioteket ditt 

Ulike typer av grupper 

Referanser som ikke 
tilhører noen gruppe 
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midlertidige grupper. Det betyr at innholdet i gruppene fjernes/endres når man lukker 

programmet/biblioteket. Innholdet endres når man foretar et nytt søk, sletter, importerer 

eller overfører nye referanser. 

 

Opprette gruppe   
 
1. Lag en gruppe ved å velge Groups > Create Group  eller høyreklikk når du står i 

Groups-feltet.  

2. Gi gruppen et navn 

3. Legge referanse(r) til en gruppe: Merk ønskede referanser 

Dra aktuell referanser inn i gruppen eller  

Marker og høyreklikk, velg Add references to...   

Velg mellom å opprette en ny gruppe eller finn den aktuelle gruppen fra menyen 

4. En referanse kan legges i flere grupper. 

 
Slette referanser fra en gruppe 

Velg gruppen, merk referansen(e) og trykk Delete-tasten.  

Vær klar over at referansen ikke slettes fra biblioteket, kun fra den aktuelle gruppen. Du vil 

altså finne igjen referansen under All References.  

Den eneste måten å fjerne en referanse totalt fra biblioteket, er å slette den fra All 

Reference (da vil den også bli fjernet fra de gruppene den har vært plassert i). 

 

Slette grupper 

På samme måte som når en sletter referanser fra en gruppe, så vil ikke referansene som er 

i en gruppe bli slettet selv om en sletter en gruppe. Referansene vil kun bli slettet fra 

gruppen, ikke fra EndNote-biblioteket. 

 

1. Merk gruppen som skal slettes 

2. Velg Delete Group  fra Groups-menyen 

3. Eller 

Høyreklikk på gruppen og velg Delete Group 

 
 

Opprette Smart Groups   
 
Dette er grupper som automatisk lagrer referanser fra ditt bibliotek ut fra de 
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kriterier/søkestrategier du definerer.  Dersom nyinnlagte referanser stemmer overens med 

dine søkekriterier vil gruppene automatisk bli oppdatert.  

Eksempel: alle referanser med et gitt emneord legges automatisk i en og samme gruppe 

 

1. Lag en gruppe ved å velge Groups > Create Smart Group   

eller høyreklikk når du står i Groups-feltet.  

2. Gi gruppen et navn 

3. Fyll ut søkeskjermen med de ønskede kriteriene 

4. Klikk på Create  

 

Fremgangsmåte fra søkemodulen:  

Når en gjør et søk i EndNote-

biblioteket eller en søker i databaser 

via EndNote  kan en klikke Options og 

velge Convert to Smart Group 

 

Forskjellen mellom Smart Groups og Custom Groups ligger i automatikken. For å få 

referanser inn i en Custom Group må du dra dem inn manuelt, noe du slipper med Smart 

Groups. 

 
 

Bibliografisk stil (Output Style) 
 
Den bibliografiske stilen bestemmer hvordan kildehenvisningene og litteraturlisten skal se ut.  

Stilen bestemmer rekkefølgen på forfatter, årstall og tittel, bruk av punktum, parenteser, 

kursivering etc.  

EndNote tilbyr over 4500 bibliografiske stiler og du finner stiler som APA, Harvard, Chicago, 

Vancuver, samt en rekke stiler tilpasset ulike tidsskrift. 

Velg stil 

1. Gå til rullgardinmenyen og velg Select Another Style   

Du får opp en liste over tilgjengelige stiler 

2. Marker ønsket stil og klikk på Choose  

Tidligere benyttede stiler legger seg automatisk i rullgardinmenyen 
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Hvilken stil skal jeg velge? 

 
EndNote X3 og senere versjoner leveres kun med de mest brukte stilene. Finner du ikke 

riktig stil kan flere lastes ned fra EndNotes hjemmeside. EndNote legger jevnlig ut nye og 

oppdaterte stiler. Disse finnes på: www.endnote.com/support/enstyles.asp Vi anbefaler kun 

import av enkeltstiler slik at programmet ikke blir for tungt. 

 

Dersom du ikke finner en du kan bruke, kan du gjøre endringer i en eksisterende stil, eller 

lage helt nye. Ta kontakt med biblioteket dersom du har behov for dette. 

 

På HiL benyttes APA 6th og Harvard (basert på Chicago 16B). 

 
Norske tilpassede stiler (APA/Harvard) 

Biblioteket har utviklet en norsk versjon av Harvard- og APA-stilen. 

 

For mer informasjon og nedlasting: 

http://www.hil.no/biblioteket/forskning_og_publisering/endnote/endnote_stiler 

 

Ordlister (Term Lists) 
 

”Term Lists” er EndNotes betegnelse på ordlister over alle termer brukt i bestemte felt. Det 

finnes ordlister for feltene Author, Journal og Keywords.  

Hensikten med ordlistene er å ha kontroll over hva som legges inn og sikre konsekvent bruk 

av skrivemåter. 

 

Listene oppdateres automatisk når du importerer referanser eller manuelt registrerer nye 

referanser. 
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Ved manuell registrering av en referanse får du opp forslag fra ordlistene når det skrives i 

feltet. Hvis termen som skrives inn ikke finnes fra før, markeres det med rød skrift fram til 

referansen er lagret.  

 

Åpne/se på ordlister 

Tools > Open Term Lists > velg liste 

NB. Vær klar over at endring/sletting av en term i ordlista, ikke automatisk endrer/sletter 

termen i referansene dine. Det kan du gjøre ved å bruke Change Text (se s. 11 ) 

 
 

Få referanser inn i biblioteket 

 
Det er ulike måter å få referanser inn i biblioteket: 

• Legge inn referansene manuelt (se eget kapittel). 

• Importerere referanser fra databaser 

• Bruk EndNotes Online Search for å søke i databaser 

• Registrere referanser ved hjelp av pdf-filer 
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Importerere referanser fra databaser 

Du kan søke i litteraturbaser som Bibsys Ask, Academic Search Premier etc. for deretter å 

importere aktuelle referanser til EndNote.  

Dette kan gjøres på flere måter, avhengig av hvilken database du søker i. 

 

• Søk i databasene 

• Marker de aktuelle referansene 

• Velg eksporter til EndNote (Direct Export, Download Citations etc. )  

 

Nedenfor vises hvordan det gjøres i BIBSYS Ask og Norart. 

Veiledninger for andre databaser finnes på bibliotekets EndNote side. 

 
 

Huskeregel!  Se alltid  gjennom de referansene du har overført.  

Har opplysningene havnet i riktig felt? 

Mangler det opplysninger? 

Rydd opp i bruk av emneord  

Slett eventuelt innhold du ikke trenger. Fjern f.eks s. eller p. for sidetall 

 
 
Når nye referanser er importert til ditt EndNote-bibliotek vil kun de nylig importerte posten 

vises (Imported References). På statuslinja vil det alltid stå antall referanser i ditt bibliotek, og 

hvor mange av dem som vises nå. For å se alle referansene i ditt bibliotek, velg All 

References. 

 
 
Bibsys Ask 

 
1. Gjør et søk og hak av ønsket referanse(r) fra trefflista 

2. Velg Send til EndNote         

3. Nedlasting av filer: velg Åpne/Open 

4. Referansene settes inn i biblioteket ditt 

 

 

Overføring av flere referanser fra BIBSYS Ask 

Dersom du ønsker å eksportere referanser fra flere trefflister/websider;  

1. Hak av for de referansene som skal eksporteres  
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2. Klikk på [Legg i samlekurv] for hver treffliste/webside 

3. Velg [Samlekurv]fra toppmenyen 

4. Velg Send til EndNote…. 

 

 
 
 
Vanlige feil ved import fra BIBSYS Ask: 

Utgave  – utgaveopplysninger legges ikke i riktig felt. Det legges i Notes. Flyttes til Edition-

feltet 

Redigerte bøker/antologier  – får Reference Type Book, må endres til Edited book. 

Kapittel i bok  – informasjon om bokas redaktør(er) kommer ikke med. Må legges inn 

manuelt 

Forfatter  - se til at ikke illustratører, oversettere o.l.  havner i forfatterfeltet. 

Sidetall  – slett s., ill. eller annen informasjon som ikke skal være der. 

 
 
Mellomlagring og import av referanser via importfil ter 

 
I noen databaser (f.eks Norart), må referansene først lagres som en txt-fil, før denne 

importeres inn i EndNote ved hjelp av riktig importfilter. EndNote har en rekke filtre 

(konverteringsfiler) som gjør det mulig å importere referanser i ulike formater fra forskjellige 

databaser. 
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Endnote lager stadig nye filtre og disse kan lastes ned fra EndNotes egen webside: 

http://www.endnote.com/support/enfilters.asp 

 
Norart 

 
1. Utfør søket i Norart 

2. Hak av ønsket referanse(r) fra trefflista 

3. Eksporter referansene (nederst på siden) 

 

 

 

 
 
4. Velg Fil → Lagre som, Velg lagringssted og navn, lagres som tekstfil (txt-fil) 

5. Åpne EndNote 

6. Velg File – Import  

7. Velg riktig fil ved Import Data file 

8. Velg riktig importfilter: Reference Manager(RIS)  

9. Importer 

 

 
 
 

NB!  De importerte referansene fra Norart  inneholder mange feil. Biblioteket har derfor laget 

et forbedret filter til bruk ved import fra Norart til EndNote.  

Men du må fremdeles sjekke referansene og gjøre eventuelle endringer! 

Velg formatet: RIS Import 

Velg den lagrede 

tekstfilen som skal 

importeres 

Velg riktig 

importfilter 

(konverteringsfil) 
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For mer informasjon og nedlasting: 

http://hil.no/biblioteket/forskning_og_publisering/endnote/files_filters#Filter 

 

Søk i en database via EndNote (Online Search) 

Dette er en løsning som egner seg best dersom det er bestemte referanser en leter etter. For 

avanserte søk anbefales direkte søk i den enkelte database.  

Hvilke databaser som er tilgjengelig avhenger av hvilke HiL har abonnement på.   

1. Koble deg opp til den aktuelle databasen ved hjelp av  eller gå via Tools > Online 

Search , og navnet på den basen du vil søke i.  

2. Klikk deretter på Choose  

Referansene blir importert direkte inn i biblioteket. Husk derfor å slette referansene 

dersom du ikke ønsker å beholde dem. 

 

EndNote husker hvilke baser du har søkt i så etter hvert vil du se tidligere brukte  

databaser listet opp i venstre menyen under Online Search. 

 

Aktuelle databaser: 

• Academic Search Premier (EBSCO) 

• Web of Science (TS)   

• PubMed (NLM) 

• BIBSYS (Library Catalogs) 

 

BIBSYS Ask 

EndNote X5 mangler den nødvendige Connection File for søk i BIBSYS Ask. Du er derfor 

nødt til å installere denne selv før du kan starte søkingen: 

http://www.hil.no/biblioteket/forskning_og_publisering/endnote/files_filters#BIBSYS 

 

Du har ikke mulighet til kun å søke i HiLs lokale base. 
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Registrering av referanser ved hjelp av pdf-filer 

EndNote kan automatisk opprette en referanse basert på en PDF-fil og samtidig knytte PDF-

filen til referansen som blir opprettet i biblioteket.  

Merk at det kun er mulig å opprette en referanse basert på en PDF-fil dersom PDF-filen er 

forlagsprodusert (ikke skannet) og inneholder DOI-informasjon  (Digital Object Identifier). 

 

Du kan importere én og én fil, eller en hel mappe med filer på en gang. 

 

1. Velg File > Import   

2. Velg File ... * 

3. Klikk på Choose, og finn PDF-filen 

Velg PDF under Import Option 

4. Klikk Import 

 
 

 
* eller Folder dersom du har samlet flere pdf-filer i en mappe. 



Lage en selvstendig litteraturliste/bibliografi 
 
Du kan benytte Cite While You Write-funksjonen for å lage en litteraturliste (se neste kapittel), 

men det er mulig å opprette litteraturlister også på andre måter.  

Du kan lage det som i EndNote kalles independent bibliography.    

 

1. Velg ønsket Output Style (bibliografisk stil) 

Marker de referansene du ønsker skal med i litteraturlista 

 

2. Deretter finnes ulike måter å gå videre på: 

• Velg Copy Formatted  fra Edit-menyen 

• Lim inn i Word 

   

• Velg File > Export  eller  

Lagre filen som Rich Text Format (*.rtf). En rtf-fil kan åpnes i alle tekstbehandlings-

program. 

• Åpne rtf-fila i Word. 
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EndNote & Word 
 
Det er kobling mellom EndNote og Word slik at du kan legge referanser fra ditt bibliotek  

inn i teksten og automatisk få opprettet en litteraturliste til slutt i dokumentet. Denne funksjonen 

kalles Cite While You Write (CWYW). 

 
NB!   Du kan spare mye tid i arbeidet med kildehenvisning og utarbeidelse av en ferdig 

litteraturliste ved å benytte denne funksjonen. Gitt at du gjør det på riktig måte! Endringer i en 

referanse og sletting av en referanse må f.eks gjøres på rett måte. 

 
Ha alltid EndNote oppe når du jobber med Word-dokumenter som skal ha referanser 

 

EndNotes verktøylinje i Word 

I Word 2003 ser verktøylinja slik ut: 

 

 
  
 
Word 2007: EndNote kommandoene vises i en egen fane i toppmenyen 
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Sette inn en referanse 
 
Det er ulike måter å sette inn referansene i den løpende teksten på: 

  Insert Selected Citation(s)  

 

1. Merk ønsket referanse i ditt EndNote-bibliotek 

2. Gå til Word-dokumentet og plasser markøren der hvor du vil ha referansen  

3. Velg Insert Selected Citation(s).   

Referansen settes inn i teksten og samtidig legges referansen inn i en litteraturliste sist i 

dokumentet. 

 

  Find Citation..   

 

1. Sett markøren der hvor du vil ha referanse 

2. Velg Find Citation  og søk opp referansen i Find-feltet 

3. Merk ønsket referanse (eller dobbeltklikk på den) og velg 

Insert. 

Referansen settes inn i teksten og samtidig legges referansen 

inn i en litteraturliste sist i dokumentet. 

 

Dersom du klikker på pilen til høyre for Insert får du flere valg: 

 

Word 2007: 

 

 

 

 

 
Insert   Setter inn siteringen på ordinær måte 

Insert & Display as: Author 

(Year) 

Setter inn siteringen ved å plassere årstall i parentes og forfatter i 

teksten 
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Insert & Exclude Author Setter inn siteringen uten å ta med forfatternavn 

Insert & Exclude Year Setter inn siteringen uten å ta med årstall 

Insert in Bibliography Only Setter inn siteringen kun i litteraturlisten, ikke i den løpende teksten 

 

Hver gang du setter inn en ny referanse vil litteraturlisten automatisk oppdateres. 

Endre (redigere) en referanse i teksten 

Ikke gjør endringer i referansen ved å skrive inne i den, da vil endringene forsvinne neste gang 

dokumentet formateres. Bruk heller ikke Delete eller backspace for å slette referanser. Ønsker 

du å sette inn sidetall, fjerne årstall eller forfatter må funksjonen Edit & Manage Citation(s)  

benyttes. 

 

Under fanekortet Edit & Manage Citation(s) er det mulig å: 

• fjerne forfatternavn fra siteringen  

•  fjerne årstallet fra siteringen  

•  legge til tekst før selve referansen (Prefix) 

•  legge til tekst etter selve referansen (Suffix) 

•  legge inn sidetall  
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Sette inn sidetall 

1. Marker den aktuelle referansen  

2. Velg Edit & Manage Citation(s) fra verktøymenyen  

3. Skriv inn sidetall i feltet Pages f.eks 13 

4. Klikk på OK for å lagre endringene 

 

Pages-feltet kan kun benyttes – er synlig – hvis Cited Pages er brukt i den valgte stilen. 

I noen stiler anbefales det å bruke Suffix-feltet i stedet. Vær oppmerksom på at da må alle 

tegn/bokstaver/mellomrom skrives inn manuelt. 

 

Fjern forfatternavn 

I tilfeller hvor forfatternavnet er nevnt i selve teksten er det ikke nødvendig å gjenta 

forfatternavnet i referansen. Slik fjernes forfatternavnet fra referansen: 

 

1. Marker den aktuelle referansen  

2. Velg Edit & Manage Citation(s ) fra verktøymenyen  

3. Velg Exclude author fra nedtrekksmenyen 

4. Klikk på OK for å lagre endringene 

 

Slette referanser  

Ikke benytt Delete/Backspace på tastaturet da dette ikke 

vil slette referansene i litteraturlista. 

 

1. Marker den referansen i teksten som ønskes slettet 

2. Velg Edit & Manage Citation(s ) fra verktøymenyen  

3. Fra nedtrekksmenyen Edit Reference finner du 

Remove Citation , 

4. Klikk deretter på OK for å lagre endringene 
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Henvisning til flere forfattere samtidig 

Når du refererer til to eller flere kilder samtidig, skal referansene stå i samme parentes.  

Dette gjøres ved å merke alle de aktuelle referansene, for så å sette dem inn samtidig (se for 

øvrig kap. Sette inn en referanse).  

Har du allerede satt inn en referanse og ønsker flere innenfor samme parentes? Markér 

referansen (slik at den blir grå) og sett deretter inn en referanse på vanlig måte.   

 

Velge bibliografisk stil i Word 

Word 2007: 

  
 
 
 
 
Word 2003: 

Velg Format Bibliography  for å velge/skifte 

stil  

Velg stil i feltet With output style eller klikk på 

Browse for å finne flere stiler 

Klikk på OK. Alle referansene og litteraturlista 

endres nå i samsvar med den valgte stilen. 

 

 

Fra nedtrekksmenyen Style  kan du 

velge/skifte stil.  

Velg Select Another Style for å finne 

flere stiler. 
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Oppdager du feil i referansene i litteraturlista?  

Utseende på litteraturlisten avhenger som sagt av hvilken stil som er valgt.  

Dersom du oppdager feil i litteraturlisten så må dette rettes opp i EndNote-biblioteket.  

 

Etter at du har gjort endringene, velg Bibliography  fra Endnotes verktøylinje for oppdatering av 

litteraturlisten i Word.  

 

Word 2007:  

 

NB!  Dersom det gjøres endringer i forfatternavn og årstall så vil ikke disse endringene bli 

oppdatert i Word. Du må derfor slette referansen for deretter å sette den inn igjen på nytt. 

 

Slå sammen flere dokumenter til ett med felles litt eraturliste   

Før du slår sammen flere dokumenter til ett er det viktig at du fjerner formateringen av 

referansene i Word-dokumentene. Velg deretter å formatere på nytt etter at dokumentene er 

sammenstilt.  

Det er viktig at en har brukt samme EndNote-bibliotek til alle dokumentene som skal settes 

sammen til ett.  

 

Lag sikkerhetskopier av dokumentene før du starter 

Sett alle referansene i de ulike del-dokumentene til 

uformatert slik: 

 

Word 2007: 

Klikk på Convert Citations and Bibliography  i EndNotes 

verktøylinje. Velg Convert to Unformatted Citations. 

 

Word 2007:  

 

 

Word 2003:  

Klikk på knappen for avformatering  
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Litteraturlistene vil nå bli ”borte” og siteringene i dokumentene vil se slik ut {Everett 2004#5}. 

Sett sammen alle del-dokumentene til ett dokument 

Slå på formateringen igjen slik: 

Word 2007:  

Klikk på Update Citations and Bibliography. 

 

Word 2003: 

Klikk på knappen for formatering  

 

Du vil nå få en felles litteraturliste til slutt i dokumentet. 

 

Fjern feltkodene før du videresender dokumentet  
 

Før du sender fra deg et dokument til veileder, til forlag, trykking eller konverterer til pdf skal 

feltkoder fjernes. Det vil si at du lagrer en kopi som fjerner koblingen mellom Word og EndNote. 

Referansene og litteraturlisten lagres som ren tekst. 

Dette gjelder også dersom du videresender dokumentet ditt til noen med en annen word-

versjon. 

 

Det kan være smart å ta vare på en kopi av dokumentet med kodene intakt, da det ikke er mulig 

å gjenskape koblingene igjen etter at de er tatt vekk. 

Denne funksjonen lagrer et nytt dokument uten feltkoder. Det nye dokumentet åpnes i et nytt 

vindu. Originaldokumentet blir ikke endret. Kopien kan så videresendes. 

 

Word 2003:  

Vis > Verktøylinjen > EndNote X3 > Remove Field Codes  

 

Word 2007:  

 

 


